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ABSTRACT
Aims  To propose diagnostic criteria for a presumed 
incipient choroidal melanoma based on tumour growth 
rate and tumour doubling time (TDT) and to describe 
management of such tumours with transpupillary 
thermotherapy (TTT).
Methods  Retrospective interventional case series of 
nine consecutive presumed incipient uveal melanomas 
diagnosed and treated with TTT in 2010–2017. Growth 
rate in mm/year and per cent/year in largest basal 
diameter (LBD) and TDT were compared with published 
data for uveal melanomas and growing naevi that did 
not transform to melanoma under long-term follow-up.
Results  The median LBD and thickness were 1.6 mm 
(range 0.9–2.3) and 0.20 mm (range 0.15–0.29), 
respectively. The median age was 57 years (range 
47–78). Seven tumours were classified as de novo 
melanomas and two as transformed naevi. The median 
time from first observation to diagnosis was 3.3 years 
(range 2.2–7.3), LBD growth rate 0.25 mm/year (range 
0.11–0.72) and 34 per cent/year (range 10–1437), and 
TDT 609 days (range 97–1612). The estimates matched 
those reported for uveal melanoma (median TDT 521 
days, 90th percentile 2192) and exceeded those for 
growing naevi (median growth rate 0.04 mm/year, 90th 
percentile 0.12; 1.1 per cent/year, 90th percentile 2.6). 
The predicted median age at de novo appearance was 51 
years (range 32–63). No tumour grew after TTT during a 
median follow-up of 2.1 years (range 0.6–8.7).
Conclusions  In this series, relative growth rate and 
TDT best qualified as diagnostic criteria for an incipient 
choroidal melanoma. Too small for brachytherapy, they 
could be managed with TTT.

Pathogenic variants in driver genes of choroidal 
melanomas appear to arise early during their 
evolution, an estimated 9.5 years or more before 
diagnosis of the primary tumour.1–3 Five of 14 
melanomas 2 mm or less in thickness had a gene 
expression profile (GEP) class higher than 1A, and 
4 of 11 showed monosomy 3.4 Metastatic dissem-
ination also can occur early.5 In the Small Fatal 
Choroidal Melanoma Study, the smallest melanoma 
that metastasised was 3.0 mm in largest basal diam-
eter (LBD) and 1.0 mm in thickness at the time of 
treatment.6 These findings support early treatment 
to minimise the risk of metastasis, but capability 
to disseminate cannot be predicted from clinical 
characteristics of small choroidal melanomas6 7 and 
they also are challenging to biopsy early in their 
development.

We are unaware of diagnostic criteria for 
choroidal melanomas less than 3 mm in LBD and 

of reports describing treatment of such tumours. 
Descriptions of choroidal melanomas that emerged 
de novo are exceptional.8 9 Here, we propose diag-
nostic criteria for a presumed incipient choroidal 
melanoma based on assessment of tumour growth, 
and report a consecutive series of nine such tumours 
treated with transpupillary thermotherapy (TTT).

METHODS
Inclusion criteria
Eligible were patients diagnosed with a presumed 
incipient choroidal melanoma and scheduled 
to have primary TTT between June 2010 and 
October 2017. We reviewed the database of the 
Ocular Oncology Service, Department of Ophthal-
mology, Helsinki University Hospital, a national 
referral centre for uveal melanoma and identified 
nine eligible patients (for case reports, see online 
supplemental text 1). One of them had a history of 
a T2aN0M0, stage IIA, choroidal melanoma in the 
same eye, treated with a 15 mm ruthenium plaque 
2.5 years earlier.

Clinical evaluation
We used digital fundus images, taken with a fundus 
camera in other hospitals at various times before 
referral and in our service (TRC-50DX, Topcon, 
Tokyo, Japan), to localise tumour margins, to 
measure its diameter and distance from the foveola 
and the optic disc, and to record orange pigment. 
We used enhanced depth imaging10 spectral-domain 
optical coherence tomography (OCT; Spectralis, 
Heidelberg Engineering, Heidelberg, Germany) to 
measure tumour thickness and to detect subretinal 
fluid. We measured best-corrected visual acuity 
(BCVA) using a test-type projector (Rodavist 2 and 
524; Rodenstock GmbH, Ottobrunn, Germany, 
and TCP-2000A, Tomey, Nagoya, Japan).

Diagnosis at the time of treatment was based 
on calculated annual absolute tumour growth rate 
and tumour doubling time (TDT) and the age of 
the patient, relative to published data of growing 
choroidal naevi.11 We collected age, gender, 
BCVA, tumour size and location, risk factors for 
growth,12 13 and TTT parameters. Data collected 
after TTT included BCVA, tumour control, adverse 
outcomes and last survival status.

Calculation of tumour growth rate and doubling 
time
We calculated tumour growth rate both in mm/year 
and per cent/year from initial LBD. A theoretical 
LBD of 0.05 mm was used for two tumours that 
were not visible in the first available photograph.
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We calculated TDT by using tumour volume estimated from 
cylindrical shape because all tumours were non-elevated relative 
to the adjacent choroid. We presumed that their thickness did 
not change, that is, the tumour replaced the full thickness of the 
choroid already when first photographed. Thus, tumour thick-
ness was taken to equal choroidal thickness. LBD and surface 
area were measured with ImageJ (V.1.51, National Institute of 
Health, Bethesda, Maryland, USA).14 Two investigators (SJ, RAJ) 
independently measured them both with manual drawing and 
with automatic recognition of tumour margins (for protocol, see 
online supplemental text 2). The estimate used in calculations 
was the mean of the four measurements (online supplemental 
table). The time of the first observation was the date when the 
tumour was first photographically documented. The time of 
diagnosis was the day when the photograph leading to the diag-
nosis of a presumed incipient melanoma was taken. Observation 
time was the difference between these dates.

We calculated TDT according to Schwartz15:

	﻿‍

TDT = T

log10

(
Vdg
Vini

)

log10
(
2
)




‍�

(1)

where Vini=initial tumour volume, Vdg=tumour vol at diag-
nosis and T=observation time.

We also calculated the predicted age at which the tumour 
likely would have been clinically invisible, using 0.05 mm as 
theoretical LBD and thickness, to assess whether it likely had 
originated during adult life and was, thus, consistent with a de 
novo melanoma:

	﻿‍ Agepred = Ageini
TDT×

log10

(
Vini
Vorig

)

log10
(
2
)

365.25 ‍�
(2)

where Ageini=age when tumour was initially observed; 
Vini=initial tumour volume; Vorig=theoretical vol 0.000125 mm3 
based on 0.05 mm dimension and TDT=tumour doubling time 
from (equation 1).

Our calculations are based on constant exponential 
growth,16 which may differ from the actual growth rate of the 
tumour over time. We performed a sensitivity analysis for one 
patient with a previously documented stable naevus (table 1 
and online supplemental text 1; patient 7) by calculating 
the observation time from two immediately preceding visits 
(without photograph), thus allowing for the possibility that 

minor growth might have been missed during the immediately 
preceding visit. A likely de novo melanoma was diagnosed 
when a tumour grew symmetrically in all directions and a 
previously normal fundus was either documented or predicted 
to have been present in adult life.

Reference data
As a reference for growth rate of choroidal naevi during long-
term observation, we used a study that reported absolute 
overall growth for 89 naevi with photographic evidence of 
enlargement without clinical signs of malignant change devel-
oping over a median follow-up of 15 years.11 Carol Shields 
(Wills Eye Institute, Thomas Jefferson University, Philadel-
phia, Pennsylvania, USA) kindly provided us the data to calcu-
late corresponding annualised growth rates, with a median 
of 0.04 mm/year (range 0.01–0.20; 90th percentile 0.12) 
and 1.1 per cent/year (range 0.2–11.6; 90th percentile, 2.6), 
excluding one fast growing tumour that soon had been diag-
nosed as a choroidal melanoma (unpublished observations).

As a reference for known choroidal melanomas, we collected 
the patient-level TDT of 196 uveal melanomas reported in 
four articles.17–20 TDT was either reported in a published table 
or, for 145 patients, derived from published histograms.20 
Omitting two outliers with a very long TDT of more than 
32 and 64 years,20 the median was 521 days (range 10–8766; 
90th percentile 2192).

Transpupillary thermotherapy
Three ocular oncologists (TK, MT, SE) treated all tumours 
with TTT using an 810 nm infrared diode laser (MedArt 426, 
MedArt, Hvidovre, Denmark) adapted to a slit lamp (Zeiss 
30 SL-M, Zeiss, Munich, Germany). Depending on LBD, a 
spot 0.8, 1.2, 2.0 or 3.2 in diameter was applied under perio-
cular anaesthesia through a contact lens (Area Centralis or 
Quadraspheric, Volk Optical, Mentor, Ohio, USA) after pupil-
lary dilatation. The median power and duration to achieve a 
greyish white effect during the first treatment were 1500 mW 
(range 700–3500) and 120 s (range 60–285), respectively; the 
same parameters were used during any subsequent treatment. 
Up to four (median 1) slightly overlapping applications centred 
on the tumour were delivered to cover the tumour with a 
0.5–1.0 mm margin. Treatment was repeated in six patients a 
median of two (range 2–4) times at 2 to 7-month intervals to 
achieve a white atrophic scar.

Table 1  Initial and final size, growth rate and predicted age when tumour was invisible for nine presumed incipient choroidal melanomas

Patient

Choroidal 
thickness 
(µm)

Initial size

Observation time 
(days)

Final size Growth rate Predicted

LBD 
(mm)

Area 
(mm2)

Volume 
(mm3)

LBD 
(mm)

Area 
(mm2)

Volume 
(mm3) LBD (mm/year)

LBD (%/
year) TDT* (days) NTD (X)

Interval 
(years)

Age when 
invisible (years)

1 158 0.47 0.15 0.023 1101 0.93 0.48 0.076 0.15 32 609 1.7 12.6 34

2 200 1.05 0.70 0.14 817 1.61 1.78 0.36 0.25 24 609 1.3 16.9 59

3† 191 1.09 0.63 0.12 1553 1.56 1.22 0.23 0.11 10 1612 0.95 N/A N/A

4 290 0.52 0.12 0.035 1495 1.69 1.64 0.47 0.29 55 393 3.8 8.7 51

5 150 0.56 0.11 0.017 2664 1.97 2.31 0.35 0.19 34 601 4.4 11.7 32

6‡ 179 0.05 0.0025 0.00045 1364 2.32 1.54 0.28 0.61 1214 147 9.3 34.6 63

7† 200 0.56 0.15 0.030 1192/773§ 1.00 0.59 0.12 0.14/0.21§ 24/38§ 635/412§ 2.0 N/A N/A

8 227 0.46 0.17 0.039 804 1.30 0.89 0.20 0.39 85 337 2.4 7.6 47

9‡¶ 265 0.05 0.0025 0.00066 931 1.88 1.89 0.50 0.72 1437 97 9.6 0.6 53

*Equation of Schwartz.15

†Likely a transformed naevus.
‡Tumour initially invisible, modelled using presuming an initial tumour diameter of 0.05 mm.
§Sensitivity analysis, presuming minor growth present/absent at the visit immediately preceding the one at which growth was noticed.
¶In an eye with a previously irradiated choroidal melanoma.
LBD, largest basal diameter; N/A, not available; NTD, number of tumour doublings; TDT, tumour doubling time.
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Statistical methods
We prospectively collected follow-up data up to 30 June 2019, 
into a database (MS Access; Microsoft, Seattle, Washington, 
USA) and analysed them with Stata (Release V.15; Stata Corp). 
The BCVA was transformed to logarithmic scale. We summarised 
the data as median and range for continuous variables. All tests 
were two-sided and p value <0.05 was considered statistically 
significant.

RESULTS
The mean age of the nine patients (male:female (4:5)), all white 
Caucasians, was 55 years (range 41–77) when the pigmented 
choroidal tumour in a fundus photograph taken for various 
reasons was still absent in two eyes and first detected in seven 
eyes, in two eyes retrospectively (figure  1 and online supple-
mental text 1). Four were documented as presumed naevi. The 
median LBD was 0.52 mm (range 0.05–1.09; table 1). None of 

Figure 1  Clinical features of nine presumed incipient choroidal melanomas. (A1) Patient 1. A documented juxtapapillary fleck, (A2) grew within 2 
years and (A3) became a white scar after two sessions of transpupillary thermotherapy (TTT). (B1) Patient 2. A presumed naevus documented during 
screening for diabetic retinopathy, (B2) was larger in the next screening photograph (B3) and showed further growth 3.5 months later. (C1) Patient 3. 
A documented presumed naevus, (C2) grew asymmetrically within 4 years and (C3) became a stable scar with a nodule of reactive proliferation of the 
retinal pigment epithelium (RPE) 15 months after one session of TTT. (D1–D3) Patient 4. A pigmented lesion was overlooked in fundus photographs 
taken as part of glaucoma screening. It was later observed to have grown, (D4) and further growth was noticed within the next 6 months. (E1) Patient 
5. A documented peripapillary pigmented lesion was, (E2) subsequently noted to have grown with four new risk factors and, (E3) was a flat scar with 
some RPE hypertrophy 5 years after two sessions of TTT. Patient 6: in a previously normal location, (F1) a small pigmented tumour was identified in 
the next photographs taken as part of diabetic retinopathy screening, (F2) it grew further during the next 5 months and, (F3) became a scar with 
RPE pigment stippling 13 months after three sessions of TTT. (G1) Patient 7. A tiny presumed naevus was documented, (G2) grew within the next 7 
years and (G3) became a white scar 2 years after one session of TTT. (H1) Patient 8. A tiny pigmented lesion was overlooked in a screening fundus 
photograph to identify diabetic retinopathy and (H2) in the next one taken a year later. (H3) It was diagnosed as an incipient choroidal melanoma 2 
years later after further growth, (H4) and became a white scar with a few granules of RPE-related pigment 1.5 years after two sessions of TTT. (I1) 
Patient 9. A new small pigmented choroidal lesion, not visible in a previous photograph 2 years earlier, (I2) was diagnosed as an incipient choroidal 
melanoma in an eye previously treated for a T2a, stage IIA choroidal melanoma. (I3) The outcome was a white scar with a small nodule of reactive 
RPE proliferation 1.5 years after two sessions of TTT.
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the tumours showed risk features for growth, nor had a halo or 
drusen as a sign of having been long standing.

Tumour characteristics at diagnosis
By the time of diagnosis as a presumed incipient choroidal mela-
noma, one of the nine patients (median age 57 years; range 
47–78) had developed symptoms (online supplemental text 1, 
patient 5). Her tumour had developed three other risk factors: 
subretinal fluid, orange pigment and tumour margin touching 
the optic disc (figure 1). The BCVA was 6/7.5 or better, except 
6/12 in one patient with a cataract. Seven tumours were consis-
tent with a de novo melanoma, including two with a previously 
normal fundus (patients 6 and 9). In one eye the tumour devel-
oped from a previously stable presumed naevus, suggesting 
malignant change close to its centre (patient 7). In one eye, 
growth occurred at two tumour margins only, suggesting eccen-
tric malignant change of another previous naevus (patient 3). By 
the time of diagnosis, the LBD had grown to a median of 1.6 mm 
(range 0.9–2.3). The median thickness, when first measured by 
OCT, was 0.20 mm (range 0.15–0.29), the same as the thick-
ness of the adjacent choroid. The median distance of the tumour 
margin to the foveola and optic disc was 3.7 mm (range 0.5–5.3) 
and 2.3 mm (range 0–6.8), respectively.

Tumour growth rate and doubling time
The median observed time before diagnosis was 3.3 years (range 
2.2–7.3; table 1). The median observed growth in LBD was 
0.8 mm (range 0.4–2.3), and the median growth rate 0.25 mm/
year (range 0.11–0.72), corresponding to 34 per cent/year (range 
10–1437; table 1). The latter rate, which takes into account the 
LBD, was faster than that for 88 growing naevi in the published 
reference data, except for the asymmetrically growing likely 
transformed naevus (figure  2A,B; p<0.001 for both, Kruskal-
Wallis test). Restricted to the seven likely de novo melanomas, 
these rates were 0.29 mm/year (range 0.15–0.72) and 55 per 
cent/year (range 24–1437), respectively. The latter rates always 
exceeded the reference data (figure 2B).

The median TDT of 609 days (range 97–1612; table 1) for all 
nine tumours and 393 days (range 97–609) for the seven likely 
de novo melanomas were comparable with the median of 521 
days (range 10–8766) for 194 melanomas in the published data 
(p=0.74), as was their range (figure 2C).

Excluding the two likely transformed naevi (patients 3 and 7; 
table 1), the predicted interval from the time when the tumour 
would have been clinically invisible, including the observed 
interval for the two eyes in which this was photographically 
documented, was a median of 11.7 years (range 0.6–34.6; table 
1). The corresponding predicted median age was 51 years (range 
32–63; table 1), consistent with a likely de novo melanoma 
developing in adult life.

Transpupillary thermotherapy
A white scar with minor retinal pigment epithelium (RPE) 
remnants was obtained in five patients (figure 3A,E,F), a white 
scar with focal reactive proliferation of RPE in three patients 
(figure 3B,D,G), and a scar with prominent reactive RPE prolif-
eration, following an RPE tear, in one patient (figure  3C), 
according to OCT. Choroidal thickness in the treated volume 
was minimally reduced, regardless of follow-up (figure 3). One 
patient who needed five sessions of TTT had a senile cata-
ract and underwent phacoemulsification with intraocular lens 
implantation after the fourth session because of inadequate beam 
transmission.

The median follow-up after completing TTT was 2.1 years 
(range 7.5 months–8.7 years). None of the patients had devel-
oped a local recurrence, or metastases. The BCVA remained 
unchanged in seven eyes. It decreased from 6/6 to 6/12 in an eye 
with a tumour under the papillomacular bundle (patient 5). She 
later developed a macular epiretinal membrane, removed 8 years 
after TTT (figure  3D and online supplemental text 1). BCVA 

Figure 2  Tumour growth of nine presumed incipient choroidal 
melanomas as compared with reference data. For the incipient 
melanomas, hollow symbols indicate likely de novo melanomas, solid 
symbols melanomas likely developing from a previous naevus, and the 
red symbol a melanoma that developed in an eye with a previously 
treated choroidal melanoma. Annual absolute growth rate of tumour 
largest basal diameter (A) and its annual relative growth rate (B) 
compared with growth rates of 87 reference patients with a growing 
choroidal naevus without malignant change during a long-term follow-
up.11 The latter plot omits two fastest growing incipient choroidal 
melanomas with an off-scale relative growth rate of 1214 (patient 6) 
and 1437 (patient 9) per cent/year. Calculated tumour doubling time 
compared with 194 reference patients diagnosed with a choroidal 
melanoma (C).17–20 The plot omits 13 reference tumours with doubling 
times exceeding 4000 days. The red lines indicate median, the dashed 
lines the 25th and 75th percentiles (ie, IQR), and the dotted lines the 
10th and 90th percentiles. Jitter was applied to display overlapping 
observations.
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was 6/40 in one patient despite cataract surgery because of non-
exudative macular degeneration (patient 2).

DISCUSSION
Our primary criterion for managing the nine patients was a TDT 
compatible with those reported for known uveal melanoma17–20 
and relative growth rates exceeding those of choroidal naevi.11 
Supporting criteria were older age when naevi rarely grow11 and 
new naevi do not develop, appearance of a new tumour in a 
previously normal fundus, predicted appearance in adult age, or 
asymmetric growth.

The distribution of our calculated TDT matched that of 
published reference data for uveal melanomas.17–20 The median 
observed growth rate of 0.25–0.29 mm/year was 6–7 times faster 
than 0.04 mm/year reported for growing choroidal naevi.11 The 
median relative growth rate of 34–55 per cent/year was 30–50 
times faster than the calculated reference of 1.1 per cent/year. 
This rate in all seven eyes with a likely de novo melanoma 
arising in adult life was at least two times the upper range of 
the published values. We now consider such an annual relative 
growth rate, which takes the LBD into account, a clearer crite-
rion to diagnose a presumed incipient choroidal melanoma than 
the annual absolute growth rate.

It seems reasonable to say that tumours of this size can pres-
ently only be diagnosed clinically based on growth character-
istics. None of them increased the thickness of the choroid 
and were thus less than 0.3 mm thick and, with one exception, 
they were less than 2.0 mm in LBD. Until now, the smallest 
choroidal melanomas that have undergone a successful biopsy 

in experienced hands have been 2–3 mm in LBD4 7 21–24 and 
0.7–1.0 mm in thickness24–26 and thus, approximately 3–30 
times larger in volume than our presumed incipient choroidal 
melanomas.

The only risk feature associated with class 2 GEP among 217 
patients with a choroidal melanoma less than 3.5 mm thickness 
was thickness exceeding 2.25 mm,7 as compared with 0.3 mm or 
less in our study. The risk features in the Small Fatal Choroidal 
Melanoma Study that focused on 45 melanomas 3.0 mm or 
less in thickness that metastasised were similar to those for all 
choroidal melanomas of similar size.6 Twenty-one (47%) of the 
45 fatal melanomas were less than 2.25 mm in thickness. None 
was less than 3.0 mm in LBD when treated, and because the 
nine presumed incipient choroidal melanomas were less than 
2.5 mm in diameter they were very unlikely to have developed 
the capacity to metastasise, whether or not such capacity was to 
emerge in them during later tumour progression.

The study of 217 small choroidal melanomas identified one 
new risk feature associated with GEP class 2, namely age over 60 
years.7 This corresponds with the rarity of growing naevi in this 
age group.11 The authors speculated that older age is associated 
with a higher risk of a small choroidal melanoma to harbour 
a BAP1 pathogenic variant. However, 28 (62%) patients in the 
Small Fatal Choroidal Melanoma Study were younger than 60 
years. One of the two incipient melanomas with the fastest 
TDT arose de novo in an eye with a previously irradiated, non-
adjacent choroidal melanoma, and perhaps had a BAP1 muta-
tion.27 Though we cannot exclude the possibility that it was an 
implantation growth seeded subretinally, it was non-adjacent 
and developed in the choroid rather than the subretinal space in 
an area that had previously been normal.

The authors of the study of 217 small choroidal melanomas 
speculated that benefit from treating a small GEP class 1 choroidal 
melanoma, which likely harbours an EIF1AX or an SF3B1 muta-
tion, might be negligible compared with one that has a BAP1 
mutation or no mutation yet, unless growth is documented.7 
Their main argument for deferring treatment of small class 1 
melanomas was that many more patients need to be treated to 
prevent one metastasis, yet everyone is exposed to risk of visual 
deterioration. All tumours that we treated were documented to 
grow faster than choroidal naevi. The risk of delayed visual loss 
after TTT is smaller than after brachytherapy. A limitation of 
TTT as a primary treatment is the higher rate of local recurrences 
as compared with irradiation.28 For this reason, and because we 
observed relatively little choroidal atrophy despite disappear-
ance of the pigmented tumour, we recommended long-term 
follow-up for our patients,29 including B-scan ultrasonography 
because of the risk for extraocular recurrence after TTT.30 31 A 
larger number of risk features is associated with a higher rate 
of local recurrence after primary TTT.29 However, our patient 
with four risk features has not developed any recurrence during 
7 years of follow-up.

One incipient melanoma had a substantially longer TDT than 
the median and appeared to be a previous naevus that underwent 
an eccentric transformation into a melanoma, based on asym-
metric growth. The corresponding calculated growth rate and 
TDT for this tumour are underestimates, because an unknown 
proportion of it was growing. The rates for the patient who had 
a previously stable naevus before symmetric growth appeared 
may be underestimated as well, depending on how long growth 
had occurred undetected within the borders of the prior naevus.

A limitation of our retrospective study is the small number of 
patients. Our reference data share the same limitation. Measure-
ments from photographs are subjective. We aimed to minimise 

Figure 3  Postoperative optical coherence tomography (OCT) 
horizontal scans through the centre of the scar in seven patients with 
a small incipient choroidal melanoma treated with transpupillary 
thermotherapy (TTT); two patients did not have a postoperative OCT 
image available. (A) 1 year after the second TTT (patient 1, compare 
with figure 1A3). (B) 1 year and 3 months after a single TTT (patient 3, 
compare with figure 1C3). (C) 3 years after a single TTT (patient 4). (D) 
8 years and 3 months after the second TTT (patient 5, compare with 
figure 1E3). (E) 6 months after the third TTT (patient 6, compare with 
figure 1F4). (F) 1 year and 6 months after the second TTT (patient 8, 
compare with figure 1H4). (G) 6 months after the second TTT (patient 
9, compare with figure 1I3 taken 1 year later). A retinal scar with 
proliferation of the retinal pigment epithelium (arrowhead in B–D) and 
(G), a simple outer (A) to full thickness retinal atrophy (E,G), both with 
minimal change in choroidal thickness, and wrinkling of the adjacent 
retina after epiretinal membrane formation (D). Scale, 1:1 pixel (A–D); 
1:1 µm (E–G).
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bias by using the mean of four different measurements. None of 
the tumours underwent histopathological or genetic verification, 
which has not yet been reported for any choroidal tumour this 
small. Though 51 uveal melanomas in the published reference 
dataset had a histopathological diagnosis,17–19 none had under-
gone a genetic analysis. Longer follow-up is needed to confirm 
local tumour control and vision outcome after TTT in this group 
of patients.

The prognosis of metastatic choroidal melanoma has not 
improved.32 Early detection and treatment of the primary 
tumour are crucial, because small tumours have a better prog-
nosis.33 34 This is likely attributable to their lower probability 
of having acquired cytogenetic abnormalities that provide meta-
static capability.34 35 When an incipient choroidal melanoma is 
diagnosed, the risk for metastases is minimal and the risk for 
treatment-related complications low. We propose annual relative 
growth rate and TDT as criteria to identify incipient choroidal 
melanomas so that they can be treated as early as possible. 
Because fundus imaging is becoming more common, we expect 
that incipient choroidal melanomas will be diagnosed much 
more often than until now.
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METHODS 

Protocol for ImageJ 
Calculate area manually by using a mask: 

• Open the original photograph 

• Use the straight-line selection tool to make a line selection 

that corresponds to known distance  

 Analyze > Measure (the dimeter of the optic disc) 

 Analyze > Set scale (enter known distance, unit: 1.5 mm) 

• Create mask 

 Use Polygon tool to outline the tumour 

 Edit > Selection > Fit spline (to smooth the margins) 
 Edit > Selection > Create mask 

• Open a Mask image 

 Image > Adjust > Threshold (125-255 works well) 

• Make area measurements 

 Analyze; select ”Area” and ”Fit ellipse” 

• Analyze > Analyze particles; select ”Display results” and 

”Add to manager” 

• Save, and close mask 

 

 

Calculate area by automatic recognition: 
• Open the original photograph 

• Use the straight-line selection tool to make a line selection 

that corresponds to known distance  

 Analyze > Measure (the dimeter of the optic disc) 

 Analyze > Set scale (enter known distance, unit: 1.5 mm) 

• Image > Type > 8-bit 

• Image > Adjust > Threshold 

 The threshold dialog window allows you to highlight 

pixels in an image that have values within a range you define. 

Adjust the sliders so that the dark, low-value pixels turn red 

(including tumor) but those that represent other parts do not 
change. Close the threshold window without clicking any of 

the buttons. 

• Analyze > Set measurements; select “Area” and “Limit to 

threshold”) 

• Analyze > Analyze particles; select ”Display results” and 

”Add to manager” 

• Save 
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RESULTS 

Case Reports 

 Patient 1. A tiny juxtapapillary pigmentary anomaly was 

documented in a fundus photograph of a 49-year-old man by 

an optician in February 2015 (figure 1A1). In October 2017 

(figure 1A2) it had grown, and they referred him. Based on 

rapid documented growth the tumour was diagnosed as a 

presumed incipient choroidal melanoma and managed with 

two sessions of TTT at 8-month interval. The outcome was a 

flat white scar (figure 1A3), stable at 1.5 years. 
 Patient 2. A small presumed naevus close to the foveola 

was first noted in October 2014 during screening with fundus 

photography to identify diabetic retinopathy in a 77-year-old 

woman (figure 1B1). It had grown in a subsequent screening 

photograph taken in October 2016 (figure 1B2) and she was 

referred to a retinal specialist. He observed it for 3.5 months, 

noted further growth (figure 1B3), and referred her. Because 

of documented progressive growth and apparent origin in her 

50’s, based on calculated tumour doubling time, the tumour 

was diagnosed as a presumed incipient choroidal melanoma 

and managed with five sessions of TTT. The first 4 sessions 
did not produce an adequate response because of cataract, 

necessitating its extraction before the last TTT session. Dry 

macular degeneration was noted. One year 2 months after the 

last session, the referring specialist reported a flat white scar. 

 Patient 3. A private ophthalmologist documented a small 

presumed pigmented naevus close to the optic disc (figure 

1C1) in a 67-year-old woman in December 2005. During a 

later appointment in March 2010 it was noted to have grown 

(figure 1C2). Based on documented, asymmetric growth we 

diagnosed a presumed incipient choroidal melanoma which 

likely originated from her small prior naevus and managed it 

with one session of TTT. The outcome was a pigmented flat 
stable scar (figure 1C3). No regrowth has occurred within 10 

years of follow-up. 

 Patient 4. A 64-year-old man was suspected of having 

glaucoma. A tiny pigmented lesion was overlooked in fundus 

photographs taken as part of glaucoma screening in August 

2012 (figure 1D1). It had grown in September 2016, and the 

patient was referred. In retrospect, we noticed that the lesion 

had progressively grown in November 2013 (figure 1D2), in 

February 2016 (figure 1D3), and in September 2016 (figure 

1D4). We diagnosed this tumour as a presumed incipient 

choroidal melanoma and managed it with one session of TTT 
that caused a retinal pigment epithelium (RPE) tear. It healed 

with reactive proliferation of the RPE, and further sessions 

were not administered. No relapse has occurred within three 

years and 5 months from the TTT treatment 

 Patient 5. A private ophthalmologist had taken a fundus 

photograph of a small peripapillary pigmented lesion in a 50-

years-old woman in February 2003 (figure 1E1). In June 

2010, she noticed decreased vision. The lesion had grown 

notably (figure 1E2) and it had 4 risk factors for malignancy 

(subretinal fluid, symptoms, orange pigment, and margin 

touching optic disc). Together with fast growth the tumour 

was diagnosed as a presumed incipient choroidal melanoma. 
The  tumour   was not  well suited  for  brachytherapy  because 

 

 

of its small size and location next to the optic disc, coinciding 

with the optic nerve sheath behind. Despite its location in the 

papillomacular bundle and thus predicted marked reduction 
of vision, she elected TTT. We treated it with two sessions of 

TTT two months apart, resulting in a partly pigmented flat 

scar. A tiny bleeding was noted after the second session. Two 

years after treatment her best corrected visual acuity (BCVA) 

was 20/40 with eccentric fixation (figure 1E3). Five years 

later, she had a symptomatic vitreous detachment that left her 

with a macular epiretinal membrane and a drop in BCVA to 

20/100. She has recently undergone vitrectomy.  

 Patient 6. A small presumed naevus, in a location where 

it was not detectable upon reviewing her first fundus images, 

taken at a screening for diabetic retinopathy in January 2014 
(figure 1F1), was noticed in May 2017 (figure 1F2) in a 67-

year-old woman. Her father had a history of renal cell cancer, 

and a second cousin had died of conjunctival melanoma. She 

did not carry BAP1 pathogenic variants. Because it was a de 

novo tumour and showed growth during a 5-month interval 

before she was referred, we diagnosed a presumed incipient 

choroidal melanoma (figure 1F3) and treated it with three 

sessions of TTT. Two years from the last TTT treatment, the 

outcome is a flat white scar with a few pigment granules. 

 Patient 7. A 47-year-old woman had regularly been seen 

by her ophthalmologist because of ocular hypertension, and 

a tiny presumed choroidal naevus was first documented in 
April 2002 (figure 1G1). In February 2006 and April 2007, 

it was stable. In May 2009, it was first noticed to have grown 

(figure 1G2) and she was referred. Because of recent growth 

we diagnosed a presumed incipient choroidal melanoma and 

managed it with one session of TTT. The outcome at one year 

was a flat white scar with some pigment (figure 1G3) that is 

stable at 11 years. 

 Patient 8. A tiny pigmented lesion was overlooked in 

April 2010 (figure 1H1) and in March 2011 (figure 1H2) 

when it was first noted during screening with fundus 

photography to identify diabetic retinopathy. It had further 
grown in May 2013 (figure 1H3). The 56-year-old man was 

referred, and we diagnosed a presumed incipient choroidal 

melanoma and managed with two sessions of TTT with a 3 

month interval. The outcome at 11 months was a flat white 

scar with a few granules of pigment (figure 1H4) stable 5 

years later. 

 Patient 9. We diagnosed a 54-year-old man with a T2a, 

stage IIA, medium-sized choroidal melanoma that was 5.0 

mm in height and 10.8 mm in LDB, located inferotemporally 

with an exudative retinal detachment extending to the fovea, 

and managed it successfully with ruthenium brachytherapy 

in March 2014. In June 2016, just above the superotemporal 
vascular arcade in a previously normal area (figure 1I1), we 

noticed a new small pigmented choroidal lesion (figure 1I2) 

and diagnosed a presumed incipient choroidal melanoma, a 

putative second primary given no evidence of breached RPE. 

We managed it with two sessions of TTT 6 months apart. The 

outcome at 1.5 years was a flat white scar and eccentric small 

patches of pigment (figure 1I3). The scar is unchanged at 3.5 

years after TTT. 
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Supplementary Table   Initial and final largest basal diameter and area of 9 presumed incipient choroidal 

melanomas that were independently measured by two investigators (SJ, RTA) both by manual drawing 

and by automatic recognition of tumour margins when measuring the area and only manual drawing 

when measuring the diameter, presuming the optic disc diameter to be 1.5 mm. 
 

 Initial Final 

  Area (mm2)    Area (mm2) 

 LBD (mm) Manual Automatic LBD (mm) Manual  Automatic 

Patient SJ RTA SJ RTA SJ RTA SJ RTA SJ RTA SJ RTA 

1 0.572 0.376 0.174 0.116 0.198 0.101 0.875 0.991 0.477 0.537 0.470 0.429 

2 1.112 0.979 0.709 0.704 N/A 0.690 1.614 1.613 1.794 1.810 N/A 1.730 

3* 1.135  1.052 0.682 0.585 0.761 0.494 1.670 1.451 1.305 1.154 1.412 1.017  

4 0.591  0.451 0.134 0.109 N/A 0.103 1.648 1.736 1.731 1.663 1.631 1.522  

5 0.590  0.534 0.141 0.094 N/A 0.077 1.980 1.963 2.366 2.541 N/A 1.980  

6† 0.05 0.05 0.0025 0.0025 0.0025 0.0025 2.449 2.186 1.993‡ 0.993‡ 2.345‡ 0.847‡ 

7* 0.571  0.539 0.165 0.142 N/A 0.131 0.941 1.053 0.576 0.560 0.733 0.492 

8 0.446  0.465 0.167 0.148 0.227 0.144 1.351 1.256 1.044 0.796 1.043 0.674  

9† 0.05 0.05 0.0025 0.0025 0.0025 0.0025 1.974 1.789 2.513 1.826 1.623 1.611  

LBD = Largest basal diameter; N/A = Not available because failure to measure with automatic recognition 

* Likely a transformed naevus 

† Tumour initially invisible, modeled using presuming an initial tumour diameter of 0.05 mm  

‡ Tumour margins diffuse and difficult to define 
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